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[bookmark: _Toc191367684]Introduction
The Guide is intended for students of the Estonian Maritime Academy for formatting various written papers. Written papers include different types of student papers submitted either electronically or on paper.
As a rule, written papers shall be submitted in PDF format and the file title shall be written in the form Last name First name_Short title of the paper.pdf.
The requirements set out in the Guide apply to all written papers unless otherwise specified by the lecturer teaching the course.
The Guide comprises the following sections:
1. Written papers and their preparation;
2. Planning and preparation of a graduation thesis;
3. Annexes, which describe in more detail how to prepare written papers.
The Guide includes links to TalTech resources for finding specialized literature and using reference management software.
The supervisor, programme director or the head of the Centre of Academic Affairs help to resolve issues/problems not covered by the Guide.


[bookmark: _Toc191367685]Ethical principles for writing (research) papers 
“Becoming a student and obtaining university education is a person’s voluntary choice and requires honest, responsible and determined commitment to studies and related research.” (Principles of Academic Ethics, TalTech).
One of the most important rules stipulates that data, texts and quotations of other authors must be properly cited (copyright). This means that, based on the citation and reference, the reader can locate the original source of the text or reasoning, verify its content, and access additional information. Extensive rewording, abstracting or quoting without proper academic citation is plagiarism. Plagiarism is not always intentional but may also be due to lack of proper referencing, and therefore, it is crucial to master correct referencing techniques when writing a student paper. Detection of plagiarism in a student paper can result in exmatriculation of the student.
A student paper shall be written in adherence to the ethical principles, which means the following:
· The survey methodology shall be described in sufficient detail to allow for replication under the same conditions.
· If the subject of a survey is people or companies and associations, the survey must be conducted in a manner that does not cause any damage to the participants (protection of personal data!).
· It is good practice to acknowledge everyone who has contributed to the thesis (those who collected data, carried out experimental procedures, proofread the text, prepared illustrations, etc.). Gratitude should also be expressed to the thesis supervisor.
· If data collected in another survey are used in a research paper, permission to use the data must be obtained from the person who collected it. Permission is not required if the survey concerns public spaces (e.g. measuring traffic density), public databases (e.g., the Statistics Estonia database), or previously published works. In such cases, it is sufficient to reference the sources.
· If a student wishes to carry out research in collaboration with an organisation, permission must be obtained from the organisation’s representative, even if the student works or undertakes internship in the organisation and has access to the organisation’s documents or other information intended for internal use. A student may observe what is going on at the host organisation or workplace for research purposes and use the information obtained in his/her thesis. However, in this case, permission must also be obtained from the organisation’s representative.
· The publication of research results should not cause damage or discomfort to the participants. For example, an in-depth interview may establish a bond between the researcher and the respondent, leading the respondent to share personal information that he/she might later regret having published.
· For the purposes of anonymity, the names of the survey participants shall generally not be disclosed, except for the officials (experts) who provide their official, rather than personal, position. If a survey is illustrated by excerpts from an interview and the interviewees are not experts, they shall be identified by a number (e.g., interviewee No 5).
· Participation in a survey is voluntary, each person surveyed has the right to refuse to participate in the survey or to change his/her mind at any point during the survey. In this case, the person's wish shall be respected. Participants in a survey shall be offered the opportunity to access the survey results.


1 [bookmark: _Toc191367686]Written papers and their preparation
1.1 [bookmark: _Toc191367687] Language of written papers
Student papers in an Estonian study programme must be written is Estonian, and in an English study programme in English. A graduation thesis shall be written in the language of the study programme or, in justified cases and with the programme director’s consent, in English.
A written paper shall be prepared using professional language and indicative mood. A written paper must be prepared using proper language and style. When using an unfamiliar abbreviation, it must be defined upon first use.
Foreign terms that retain their original spelling and pronunciation must be italicized.
All abbreviations and terms must be used consistently throughout the work. If a paper contains more than 10 unfamiliar abbreviations and/or symbols, each appearing at least three to five times, an alphabetically ordered list of abbreviations and/or symbols should be included before the introduction.

1.2 [bookmark: _Toc191367688] Types of written papers
Written papers must be formatted in accordance with the requirements established in this document. All pages of a paper are numbered consecutively, beginning with the title page. Page numbers are inserted beginning with the first page of the table of contents. The title page is included in the page count, but no number is displayed on it or its reverse side. On the other pages, page numbers must be centered at the bottom of the page. 
The types of written papers are as follows:
· an essay is a free-form expression of opinion on a topic of one’s choice or a given subject. Creative thinking and the expression of the author's personal views are essential components, and supporting evidence for claims is not required. A student is not required to use source materials in his/her essay; however, if source materials are used, they must be properly cited in accordance with the requirements set out in this Guide. An essay is typically written without a supervisor. The formatting of an essay is primarily determined by the assigned problem-solving task and the requirements set by the lecturer. The lecturer determines the required length of an essay, but the most common length is 5-7 pages.
· a report is a concise summary of the source materials or research results gathered on a specific topic. The purpose of writing a report is to gain experience in searching and working with professional literature, improve written expression, master scientific language and terminology, and acquire the skills needed for proper formatting of a paper. As a rule,  a student summarises the key points from the sources read and presents them in his/her own words. The literature consists primarily of academic sources, such as research articles, as well as materials published in the press and online. A report prepared based on a single source provides an overview of the main idea of the cited work, along with the conclusions and the author’s perspective. When multiple written sources are used in a report, the perspectives of different authors on the topic are presented and compared. The author of the report presents conclusions and his/her opinion. The number of literary sources to be used and the length of the paper shall be determined by the lecturer;
· an internship report should include a general overview of the host organization, a summary of the student’s specific tasks, the procedure of the internship, the knowledge, experience, and skills gained, and an evaluation of how well the completed internship met its established objectives. The body of the report, excluding appendixes, should be 15–20 pages (3,750–5,000 words), with literature sources used as needed. The requirements for the content of an internship report are specified in the relevant standard internship guidelines available on the website of the Estonian Maritime Academy and in the study information system;
· a term paper, such as a course paper or research paper, addresses a specific thematic problem assigned or approved by the supervisor by applying a defined research methodology. The approximate length of a term paper is 20-25 pages, with appendices added if necessary. During the process of writing a term paper, the student acquires the skills of formulating and defining a research problem, setting research goals and tasks, reviewing relevant professional literature, and analysing and summarising research results.
Each term paper must be written independently (by one student). In exceptional cases, such as participation in a research group, and with the supervisor’s consent, two or at most three students may collaborate on a joint research paper. The paper must be significantly longer than a standard term paper (20% of the total length of the paper), and  each author’s individual contributions must be clearly assigned to specific sections (the introduction, chapters, and sub-chapters);
· other written papers;
· a graduation thesis (for more details see Chapter 2).

1.3 [bookmark: _Toc191367689] Parts of a written paper
Written papers shall consist of the following parts (in the order given below):
· a title page;
· the author’s declaration (if applicable);
· an abstract (if applicable);
· a table of contents; 
· a list of figures (if applicable);
· a list of tables (if applicable);
· a list of abbreviations and acronyms (if applicable);
· an introduction;
· a body text; the theoretical framework, practical application and results
· a summary;
· a foreign-language summary along with the author’s name and the title of the paper (if applicable);
· references;
· appendices (if applicable).
The table of contents, the introduction and the headings of the sections following the summary need not be numbered. However, each of these headings shall start from a new page. Sections that are not required for the specific type of paper may be omitted where appropriate, with the approval of the supervisor/lecturer.
1.3.1 [bookmark: _Toc191367690]Abstract
An abstract is an overview of the content of the paper. An abstract must:
· be written in the same language as the paper:
· briefly summarize the thesis’s goal, methodology applied, key findings, and conclusions;
· include a research problem, research question, or hypothesis;
· be easily readable, understandable by a broad audience and function as a stand-alone text.
An abstract should not include figures or tables. At the end of an abstract, there shall be a separate line with a list of the key words referring to the topics addressed in the thesis. The textual part of an abstract (excluding the title and keywords) should be up to 250 words, and the entire abstract, including keywords, must fit on one A4 page.
1.3.2 [bookmark: _Toc191367691]Table of contents
A table of contents lists the headings of all sections, divisions and sub-divisions, starting from the introduction up to the appendices, along with the page numbers where they begin. A table of contents is generated and structured according to the headings that have been formatted with the appropriate heading style.
The table of contents comes after the abstract and is followed, if applicable, by a list of figures and/or tables.
1.3.3 [bookmark: _Toc191367692]Introduction
An introduction must include the following:
· the reasons for selecting the topic, including its relevance, significance, and novelty;
· a description of research carried out in the given field previously;
· formulation of the problem and/or hypothesis: the issue to be addressed or the hypothesis to be tested and either confirmed or refuted;
· the goal of the thesis;
· the tasks outlined or questions posed to achieve the goal;
· a definition of the research object;
· an introduction of the methodology used to achieve the intended goal;
· an explanation of the structure of the thesis; chapters, sub-chapters;
· an overview of the key source materials and references.
In the introduction, circumstances that arose during the preparation of the thesis may be highlighted, and information may be provided to help the reader better understand the content of the thesis. Such circumstances may include issues related to the representativeness and accessibility of empirical data, as well as acknowledgement of the persons or institutions that assisted in preparing the thesis.
1.3.4 [bookmark: _Toc191367693]Body of a paper
The body of a paper is divided into the following sections:
· the theoretical framework – an overview of relevant literature, previous approaches to the topic, the theoretical perspective, and the definition of the scope and criteria of the topic;
· the practical applications – the author's personal contribution, including experiments, interviews, surveys, data collection, and analysis.
· results/conclusions. - describing the results, drawing conclusions and making recommendations based on the materials from both the theoretical and practical sections.
Th body of a paper shall provide a comprehensive overview of the work carried out, starting from problem definition to the explanation and reasoning of the solutions, followed by presentation of results. The body text shall include all the essential source data and materials that explain or provide supporting evidence for the paper. All options, assumptions and simplifications must be substantiated.
In the body of a paper, the student explores solutions to achieve the goal outlined in the introduction and address the specified tasks. Generally, it is recommended to begin with broader concepts, such as theoretical foundations, methodological aspects, and research methodology, before moving on to a more detailed analysis when addressing tasks. The balance between the theoretical and practical sections depends on the chosen topic and the goal to be achieved.
The author’s analysis, comparison, and synthesis of the obtained data are crucial when presenting the results. The discussion should clearly convey the author’s opinion and perspective on the research results.
The body of a paper must be systematised based on considerations of content and style. The body of a paper shall be structured, i.e. divided into divisions and sub-divisions by using headings. The body of a paper generally includes three to five chapters, with each chapter being of roughly equal length.
It is recommended to use no more than three levels of headings, with each heading numbered to clearly indicate the division to which it belongs. The use of a new heading level is justified when a division contains more than one paragraph on the topic.
1.3.5 [bookmark: _Toc191367694]Summary
A summary is prepared by following the structure of the divisions of the body of the paper, but in the most concise form possible. A summary shall provide answers to the problems raised in the introduction and outline potential solutions to the tasks, and present the results achieved. A summary should not present any viewpoints or draw any conclusions that were not previously discussed in the main sections of the paper. The summary of a paper should demonstrate how the goal was achieved and outline the solutions proposed for the identified problems.
The primary objectives of a summary are:
· to provide a concise overview of the main results, conclusions, assessments, recommendations, etc. provided in the main body of the paper;
· to point out the potential applications of the conclusions and recommendations presented in the paper and to outline directions for further development and identify issues that require  resolution in the future.
The conclusions and recommendations should be clear, systematically organised, and presented as distinct points or statements in the text. An introduction and a summary must be presented in a way that enables the reader to understand the problems, goal, tasks, progress, and results of the thesis without needing to read the main body of the text.
A summary must include the student’s assessment of the results in terms of completion of the task set out in the paper. A summary of a graduation thesis is usually 2-3 pages.
1.3.6 [bookmark: _Toc191367695]Foreign-language summary
An Estonian-language graduation thesis must include an English-language summary, while an English-language thesis must include a summary in Estonian. A foreign-language summary is an overview of the key viewpoints and arguments. A foreign-language summary must include the following: the exact translation of the title of the thesis; the author’s name; the language in which the thesis was written, a list of key words (in the nominative case); data on the volume of the work (volume of the body text of the thesis in pages; the number of the figures, tables, formulas and appendices; the number of literary sources used); the body text of the summary.
The body of a foreign-language summary must include:
· the reasons for the relevance and novelty of the topic;
· the description of the stated problem, the hypothesis, goal and tasks;
· an overview of the  results obtained, conclusions, solutions and recommendations.
A foreign-language summary of a graduation thesis is usually 1-1.5 pages.
1.3.7 [bookmark: _Toc191367696]References
The sources used in compiling student papers must be reliable and comply  with good academic practice (scientific sources). A list of references must include all the sources directly used in the paper and cited in the body text and appendices.
1.3.8 [bookmark: _Toc191367697]Appendices
Presenting the material in appendices enables to pursue maximum conciseness and stylistic unity of the body text. It is recommended to organise supportive and supplementary information of a relatively independent nature,  as well as large tables and figures that could interfere with the readability of the main text, in the appendices. As a rule, all large volumes of information (e.g. primary data tables, specifications, results of experiments, etc.), texts or descriptions of computer programmes, supplementary or illustrative texts, detailed mathematical derivations, etc.) should be included in appendices.
1.4 [bookmark: _Toc191367698] Citing and referencing
In-text citations must always be included in the sentence immediately after summarising or quoting a source, either at the end of the sentence (before the punctuation) or, at the latest, at the end of the paragraph discussing the topic (in the last sentence before the final punctuation). If a paragraph contains information from multiple sources, citations for all sources should be listed at the end of the paragraph, following the punctuation mark. If figures and tables are included in the text, they must be properly cross-referenced. A citation must be made at the earliest (appropriate) opportunity, however, citing the same source multiple times is allowed.
In the written papers of the Estonian Maritime Academy, a consistent referencing style, such as APA style or IEEE style, must be used throughout the text. Free reference management software, such as Mendeley and Zotero, can be used to organize and manage references. These tools allow you to easily add references to your work and automatically generate a bibliography from the included sources. For more information, see the course ”How to find and cite literature sources“

[bookmark: _Toc191367699]1.5 Using AI 
The purpose of student papers, including graduation theses, is to assess the competencies acquired by the learner. A student is responsible for the content and quality of his/her graduation thesis, regardless of the sources (e.g. AI) used. TalTech’s general principles for applying AI are available here.
Purposefulness, ethics, transparency, and a critical mindset are essential when using AI. In the case of a written paper, the use of AI must be clearly described and properly referenced. Presenting content generated by AI as one’s own work constitutes academic fraud.
Using AI in a graduation thesis
When preparing a graduation thesis, a student should bear in mind that the author of a thesis is fully responsible for the accuracy and quality of all information, research material and analytical results presented in the thesis, as well as the correctness of all references. While using AI applications as a tool during various stages of graduation thesis writing is permitted, it is important to remember that AI-generated text should not be presented as your own ideas in the thesis (or in any academic work).
AI applications that process existing content – such as translation tools (e.g., Google Translate), proofreading tools (e.g., Grammarly), and reference management programs – may be used as supporting tools and do not require referencing. AI applications can be used as a source of inspiration, a tool for evaluating and refining ideas, for translation, and to support learning during the early stages of the work. AI applications can also be helpful in editing student-generated text during the final stages of the work. However, AI applications must not be used for the preparation of extensive sections of a graduation thesis (e.g. an entire chapter), fabricating data for analysis, or generating substantive arguments.
While using AI applications to gain an overview of a topic or summarise various sources (including foreign-language materials) is permitted, the student must verify the content and authenticity of the original sources cited in the graduation thesis and accurately cite the corresponding sources in the summary.
The same rules apply to AI-generated content in the thesis as in case of any other source. AI-generated content may be quoted or cited in small amounts, when justified, as long as the requirements for correct citing are adhered to. Content generated by an AI application must be properly cited and should not be presented as your own, as failing to do so constitutes plagiarism. When documenting the use of AI applications, it is important to distinguish between two situations:
1. If an application is used as a tool (for editing or translating text, creating worksheets or tests, or gathering ideas), citation is not required;
2. if the output from the application is used substantively (such as a section suggested by an AI tool or an image generated by an image creator), the application used must be properly cited and referenced;
If AI is used to compile substantial sections of a graduation thesis, it must be explained in the methodology chapter how AI was used. For example, it should be explained how the AI chatbot was used for writing a text (e.g. Example 1) or what substantive information was obtained from the AI chatbot, including the questions posed, the output generated, and the extent to which it was modified (e.g. Example 2). The description of the use of an AI application must clearly specify the extent and manner in which it has been applied in the thesis.
Example 1. The thesis was prepared using the Microsoft Copilot chatbot to gather feedback on the table of contents and the body chapters.
Example 2. The following definition is based on Microsoft Copilot's response from March 28, 2024, to the question, "What is a language model?" The result was as follows: „[—]“ (Microsoft, 2024).
In the case of an in-text citation of an AI application, it is recommended to refer to it as personal communication (Example 3), since AI applications are not published sources but rely on statistical models that produce different responses depending on the context of the interaction.
Example 3. In my thesis, I used the AI chatbot Microsoft Copilot (Microsoft, personal communication, 28.03.2024), to generate ideas for improving customer service.
The author of the AI language model,  the release year of the language model version used, the name and version of the application, a description or classification of the language model, and the web address of the application shall be included in the references.  For example, an APA style reference can be formatted as follows:
· Microsoft. (2024). Microsoft Copilot (3. märtsi versioon) [suur keelemudel]. https://copilot.microsoft.com/
· OpenAI. (2022). ChatGPT (20. detsembri versioon) [suur keelemudel]. https://chat.openai.com/
· OpenAI. (2022). ChatGPT (Dec 20 version) [large language model]. https://chat.openai.com/


[bookmark: _Toc191367700]2 Planning and preparation of a graduation thesis
An academic research paper, including a graduation thesis, is a qualitative and/or quantitative analysis of a problem relevant to the study programme through which students gain research experience and develop skills in analysis, interpretation, and generalisation of results. A research paper prepared by a student should adhere to widely accepted principles, including originality, objectivity, verifiability, reproducibility of results, accuracy, systematic methodology, and clarity. A crucial aspect of a research paper is a practical study conducted by the student, which involves applying appropriate research methods, interpreting results, and formulating conclusions and recommendations based on the analysis of collected data. A research paper is a paper written independently by a student. A student is responsible for ensuring the accuracy of the data presented and the overall content of the research paper.
A graduation thesis is an independent research or development project written by a student under the guidance of a supervisor that addresses a complex professional problem. A graduation thesis must be related to the main field of study. The aims and learning outcomes of a graduation thesis are specified in the study programme. The defence of a thesis shall be open and take place before a committee appointed for this purpose.
A graduation thesis can be written as a monograph or as an article (as a rule, the article format can be used only in case of a master’s thesis). A thesis written as an article must comply with the ETIS category 1.1., 1.2. or 3.1.
A thesis written as a monograph, like any other academic research, consists of a theoretical and a practical/empirical section. The theoretical section shall outline the theoretical framework for the research object examined in the practical section and the methods used for its analysis. In preparing a thesis, the author must draw original conclusions and make generalisations about the research object, ensuring that it is not merely a summary of previously published perspectives.
A thesis written as an article must be based on an article that has either been:
· accepted for publication in a scientific journal, is pending publication; or
· published in a scientific journal within the past two years prior to the defence, or that has not yet been accepted for publication, but is, according to the supervisor, ready for submission to a selected scientific journal.
Before writing a thesis as an article, approval from both the supervisor and the programme director must be obtained. An article may have co-authors, but the primary author must be the student submitting the work. The length of an article must correspond to that of a thesis. The quantity and quality of sources used must meet the standards required for a thesis written as a monograph. An article must be written in a manner or at a level that enables the student to achieve the learning outcomes of a thesis as outlined in the study programme. A thesis in the form of an article shall be prepared based on the formatting requirements of the scientific journal to which the article is intended to be submitted or has already been submitted for publication. If the article has not yet been published or accepted for publication, the journal’s formatting requirements (Guide for Authors) must be submitted to the defence committee as a separate file along with the thesis. If the article has not yet been published but has been accepted for publication, the journal's acceptance letter must be submitted as a separate file. A thesis shall include the full text of the article, formatted according to the journal’s requirements, including the title, authors, and all components of an article. A title page, an abstract, and an introduction shall be added before the article. A summary in the language of the study programme is provided after the article if it differs from the language of the article. The title page, abstract, introduction and summary must be formatted in accordance with the Guide. Unlike a thesis written as a monograph, the introduction must start with a separate paragraph explaining that the thesis is written in the form of an article.
Then the journal in which the article has been published or is planned to be published shall be specified. If the article has been written or is to be written with co-authors, the student’s contribution must be clearly pointed out.

[bookmark: _Toc191367701]2.1 Choosing a thesis topic and finding a supervisor
The process of writing a thesis starts with selecting a topic, formulating a research problem, and choosing a supervisor. The student is responsible for finding a supervisor and obtaining the supervisors consent on time. A student may initially select a supervisor from among the list of lecturers with expertise in the research area, considering prior interactions and previous collaborations. The programme director assists the student in selecting a supervisor, if needed. The research strategy, definitions, and methods shall be discussed with the supervisor. The supervisor assists the student in conducting research by reviewing the materials submitted and offering professional guidance and formatting recommendations.
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[bookmark: _Toc191367702]Annex 1 Formatting written papers 
	 Format and formatting requirements for written papers
	Formatting of the title page
	Formatting of the body text
	Formatting of the headings

	A student paper shall be written in A4 format (210 x 297 mm); the left, right, top and bottom margins (text-free edges) must be 30 mm, but the lecturer may, if necessary, request different margins.
The font to be used for the body text is Times New Roman or Calibri (Regular), and the font size is 12 pt and line spacing 1.5.
	The font used throughout the paper, including the body text, is used also for the title page – Times New Roman/Calibri.
The university’s logo is placed on the title page 3 cm from the top edge of the page, the location (city) and year of preparation/submission of the paper shall be placed on the bottom of the page (3 cm from the bottom edge of the paper).
A title page is formatted in Word with the help of the table formatting tool and a title page template has also been provided.
Every title page element is written on a separate line: the title of the paper, the name of the course, the type of the paper; the name of the supervisor and information on the author. (student) and  name of the study programme shall be aligned right.
	The block style (Justify) with the spacing 12 pt after paragraphs (After) is used for formatting a text . Where large spaces appear between words when using the bock style, conditional hyphenation of words may be used (Ctrl+hyphen in word processing, e.g. Word and LibreOffice Writer).
This, as well as other styles are created based on the Normal style with no specific settings - the font type and the font size have been set, line spacing is single and there is no spacing before or after paragraphs (0).
Page numbers must be centered at the bottom of the page: Insert > Page number > Bottom of page > Plain Number 2.

	A chapter heading – a first level heading – starts from a new page and is numbered using Arabic numerals; the numbering of the second level heading indicates the chapter to which the sub-chapter belongs, whereas the level numbers are separated by a dot. For example,  2.1 is the first sub-chapter of chapter 2. Similarly, a third level heading indicates, in addition to the chapter, the sub-chapter to which the sub-chapter belongs (e.g. 2.1.1).
The following styles are applied to headings: Heading 1, Heading 2 and Heading 3, from which the first one is used to format the headings of chapters, the second one to format the sub-headings i.e. the division headings and the last one to format the headings of the sub-divisions of a division. Headings are numbered as specified in the Guide.
No hyphenation and no abbreviations are used in headings and there is no full stop at the end of headings. Where a heading consists of several sentences, every sentence ends with a full stop, except the last sentence. The wording of the title of a paper shall be as brief and concise as possible.


[bookmark: _Toc191367703]Annex 2 Formatting a paper by using styles 
	Part of the document
	Style name
	Settings

	Title of the paper
	Heading title 
	Times New Roman 24 pt, Bold, Center 

	Body text 
	Body Text 
	Body Text Times New Roman 12 pt, line spacing 1,5 paragraph spacing after 12 pt, Justify

	Bulleted list 
	List Bullet 
	Font size 12 pt, hyphen bullet, line spacing 1.5
paragraph spacing 0, Justify

	Numbered list 
	List Number 
	Font size 12 pt, line spacing 1.5 paragraph spacing 0, Justify

	I level heading
Chapter heading
	Heading 1 
	Font size 16 pt, Bold, alignment left, paragraph spacing before 0 pt, after 14 pt, Arabic number, a space between the number and the text of the heading, the heading starts from a new page Page Break Before

	II level heading i.e. sub-heading or division heading
	Heading 2 
	Font size 14 pt, Bold, alignment left, paragraph spacing before 24 pt, after 12 pt, Arabic number related to the previous level, the previous level number is separated by a dot (e.g. 1.1).

	III level heading i.e. sub-heading or sub-division heading
	Heading 3 
	Font size 12 pt, Bold, alignment left, paragraph spacing before and after 12 pt, Arabic number related to the previous level (e.g. 1.1.1).

	Headings used in the paper, 
such as Table of Contents, List of Abbreviations, List of Figures, List of Tables, References, Appendix/Appendices
	Heading 1
heading numbering has been removed
	Font size16 pt, Bold, paragraph spacing before 0, after 14 pt, alignment left, starts from a new page – Page Break Before

	Table header
	Table_head 
	Font size 11 pt, Bold, alignment left, line spacing 1.15 paragraph spacing before and after 3 pt

	Table text
	Table_text 
	Font size 11 pt, alignment left, line spacing 1.15, paragraph spacing before and after 3 pt

	Table title
	[bookmark: _Hlk183600078]Caption 
	Font size 10 pt, line spacing 1.15; paragraph spacing before 6 pt and after 6 pt, centred

	Figure caption
	Caption
	Font size 10 pt, line spacing 1.15; paragraph spacing before 6 pt  and after 6 pt, centred 

	List of abbreviations and definitions (in the table) 
	Text 
	Font size 12 pt, alignment left, line spacing 1.15, paragraph spacing before and after 3 pt 

	References 
	References 
	Font size 12 pt, line spacing 1.15, paragraph spacing 11 pt 

	Footnote 
	Footnote Text 
	Font size 10 pt, line spacing 1.15, spacing before and after 0 pt 

	Content of the figure (text)
	Figure 
	Centred, spacing after 8 pt  

	Headings in the table of contents: 
Heading 1
Heading 2
Heading 3 
	 
TOC1 
TOC2 
TOC3 
	 
Font size 12 pt, line spacing 1.5; alignment left
Font size 12 pt, line spacing 1.5; indentation 0.42 
Font size 12 pt, line spacing 1.5; indentation 0.85 



[bookmark: _Toc191367704]Annex 3  Tables
Tables are used for concise, systematic presentation of data. Tables are presented in the language of the thesis. A table shall be placed in the text as soon as possible after the first cross-reference to the table.
Tables with raw data shall be presented in the appendices of the paper, while tables containing data calculated or processed (systematised) for the paper are typically included in the body text. All tables included in the appendices must be cited in the main text of the paper. It is recommended to place very large tables (those exceeding half an A4 page) in the appendices.
Tables must be numbered and supplied with a title. Either simple or multiple level numbering is used. If there are few (less than 10) tables, simple numbering is used, in which case the tables are numbered consecutively throughout the whole paper (e.g. table 7). In the case of a large number of tables, multilevel numbering is used, where tables are numbered by chapters (e.g. table 2.5), where number 2 indicates Chapter 2 and number 5 indicates the fifth table in the Chapter.
A title is a brief and clear description of the content. If a single unit of measurement applies to all data in the table, it should either be placed after the title, separated by a comma, or incorporated into the title. Numerals in table columns are aligned by decimal points.
A table title is placed above the table and the sources are cited below it. If needed, additional notes about the table can be included below it,
Formatting tables in Word
A text, numbers and graphics can be placed in a table. In addition, you can design pages by using a table (e.g. the title page).
Creating and modifying tables
To add a table, move the cursor to a new line and select the Insert tab and click the Table command to open new options. In the first case, hover your mouse over the appropriate number of rows and columns and the table will appear in the document (see  Figure 1). Inserting a table in a text).
[image: C:\Users\anhakk\AppData\Local\Microsoft\Windows\INetCache\Content.MSO\297296D1.tmp]
[bookmark: _Ref183640555]Figure 1. Inserting a table in a text
If you select Insert Table for creating a table, a dialogue box will open where you can specify the number of columns and the number of rows and the column width. The default setting is Auto, which distributes a table evenly from page edge to page edge in the field designated for a text.

[image: C:\Users\anhakk\AppData\Local\Microsoft\Windows\INetCache\Content.MSO\4FAA1207.tmp]
[bookmark: _Ref183640744][bookmark: _Ref183640729]Figure 2. Drawing a table
The Draw Table tools allow you to use a pencil for drawing a table. This option can be used for designing, e.g. a title page. You start drawing by determining the table borders - draw a rectangle and then draw appropriate lines (see Figure 2).
The Draw Table tool can be used for designing – e.g. a title page.
Once the box is created and the cursor is positioned inside the box, the Table Tools contextual tab will be displayed; this tab contains two tabs  Design and Layout.


[image: C:\Users\anhakk\AppData\Local\Microsoft\Windows\INetCache\Content.MSO\4861D0AD.tmp]
[bookmark: _Ref183640807]Figure 3. Table Tools, Design tab
The Design tab (see Figure 3) includes the following groups: Table Style Options, Table Styles, Draw Borders. From the last group you can select a pencil for drawing lines or an eraser for erasing them, you can adjust line styles and thickness or erase the lines (Eraser).

[image: C:\Users\anhakk\AppData\Local\Microsoft\Windows\INetCache\Content.MSO\20825443.tmp]
Figure 4. Table Tools, Layout tab
You need not create table lines, e.g. in case of definitions or references. You can display gridlines by clicking View Gridlines under Table Tools, on the Layout tab, in the Table group.
To ensure table titles automatically appear on the next page when a table continues on the next page, select the header row, then go to Table Layout > Data > Repeat Header Rows.
You can start filling in a table after you have created it. Click on the appropriate cell to insert data. A table may include both, texts and numbers. You can also insert graphics in tables or create lists. You can move between cells by using the Tab key or arrow keys. It is useful to know that pressing the Tab key in the last cell inserts a new row in the table. Therefore, the number of columns is essential when creating a table, rows can be easily added. However, it must be kept in mind that pressing the Enter key creates a new row in a cell which increases the column height of an entire row and paragraph spacing is applied if it has been set. It is not advisable to use it in tables. If the text does not fit in a table cell, it will automatically move to the next line of the same cell.
[image: C:\Users\anhakk\AppData\Local\Microsoft\Windows\INetCache\Content.MSO\C0131A49.tmp]
[bookmark: _Ref183640922]Figure 5. Table, row, column, and cell formatting options
If you want to wrap a text (change the line) in a text in a table cell, use the shortcut Shift+Enter. To format a table, you can use the Table Properties (see Figure 5).) option under Table Tools Here you can see options for aligning the table on a page in relation to the text  (Left, Center…).
Aligning numbers by decimal points in table columns
1. [image: C:\Users\anhakk\AppData\Local\Microsoft\Windows\INetCache\Content.MSO\F91FFC3F.tmp]To display the ruler, go to View, Ruler, then click the Decimal Tab symbol on the left side of the ruler.
[image: C:\Users\anhakk\AppData\Local\Microsoft\Windows\INetCache\Content.MSO\CBA58FA5.tmp]
[bookmark: _Ref183641036]Figure 6. Aligning numbers by decimal points in table columns
 
2. Select the table column with numbers and click the suitable place on the ruler for alignment by decimal points  (see Figure 6).
Adding table titles
Place the cursor in a table, then click Insert Caption in the References menu to open a new window. In the Caption field you can see the label Table and an automatically generated number (Figure 7).
[image: C:\Users\anhakk\AppData\Local\Microsoft\Windows\INetCache\Content.MSO\2F1C85FB.tmp]
[bookmark: _Ref183641056]Figure 7. Adding table titles and setting the number format
The text of a table title is added to the numbered table after you have clicked OK. The numbering scheme can be selected by clicking the Numbering button. If you want to display chapter numbers as well, click the Include chapter number tick box and select a period as a separator (see Figure 7).


[bookmark: _Toc191367705]Annex 4 Figures
Figures include illustrations, diagrams, graphs, geographical maps, drawings, sketches, photographs, etc.
Figures are intended for supplementing a text and/or table data. As a rule, figures are presented in the language of the thesis. A figure in a foreign language must include a caption in Estonian explaining its content. A figure should not be placed in a frame.
When creating a figure, ensure that all information is clearly visible, distinguishable, and easy to interpret. For example, if a figure includes axes, they must be clearly labelled with the variables and units.
Every figure must be mentioned in the thesis text before the figure.
Figures are numbered (automatically in Word) and supplied with a figure caption summarising what the figure depicts, whereas the caption must be clear and detailed enough. Either ordinary or multiple level numbering is used for figures. If there are few (less than 10) figures, ordinary numbering is used, in which case the tables are numbered consecutively throughout the whole paper (e.g. Figure 7). In case of a large number of figures, multilevel numbering is used, in which case figures are numbered by chapters (e.g. Figure 2.5), where number 2 indicates Chapter 2 and number 5 indicates the fifth figure in the Chapter. In addition to the title, the caption shall include information required to understand the figure, such as time values, units of measurement, etc. . Additional details about the figure, such as test conditions, meanings of the symbols, and other relevant information, are provided in the notes.
A figure caption is placed below the figure by using font size 10 pt and aligned left (style see ). A figure caption starts with the word “Figure”,  followed by the number of the figure and a full stop. The caption text begins with an uppercase letter and no full stop is used at the end . You can insert pictures by clicking Insert, Picture. Then browse to the location of the picture on your computer or select a picture from another external device and insert the picture into the text.
[image: A screenshot of a computer]After selecting the picture, you can see under Wrap Text how the picture is positioned in relation to the text (see Figure 8). In this case the option Top and Bottom is displayed.[bookmark: _Ref183641210]Figure 8. Positioning of a picture in relation to the text

[bookmark: _Piltide_vormindamine]Formatting of pictures and drawings 
1. Select the picture.
Click Format under the Picture Tools tab. 
Select Wrap text, Top and Bottom, because all the pictures/drawings in the text shall be positioned so that the text appears below the picture.
To position a picture horizontally, select Format, Position, More Layout Options and set the location of the picture (Figure 9).
[image: A screenshot of a computer

Description automatically generated][bookmark: _Ref183641254]Figure 9. Horizontal picture layout settings

[image: ]To allow sufficient space under the picture select Distance from text under Text Wrapping and set the Bottom value to 1 cm (see Figure 10).[bookmark: _Ref183641277]Figure 10. Setting the spacing between a figure and the text

Under Format, Position, More Layout Options click the Position command
(see Figure 11), select the desired position and make sure that the picture is anchored to the paragraph related to it. 
[image: ][image: A screenshot of a computer]
NB! A formatted picture is anchored to the nearest paragraph, which is displayed as an anchor symbol when you click Show/Hide. Advanced settings allow you to lock an anchor so that the anchor cannot switch to another paragraph. [bookmark: _Ref183641323]Figure 11. Anchoring a picture to a paragraph

You can find several other picture formatting options under Picture Tools, on the Format tab, e.g. you can adjust brightness, contrast and colour, compress pictures (Compress Pictures) and delete cropped areas (see Figure 12). This can be used both to crop a picture, as well as to determine which document is used - the document resolution is suitable for printing. 
[image: ][bookmark: _Ref442182412][bookmark: _Toc442266713]Figure 12. Compressing picture files



[bookmark: _Toc191367706]Annex 5  Formulas
The writing style of mathematical expressions and formulas should remain consistent throughout the paper. Simple mathematical expressions are placed in the text. The symbols for physical quantities used in the text shall be written in the form of a formula (by using a formula editor). More complex formulas expressing equality or inequality are typed on a separate line and aligned left.
Longer formulas and their transformations are placed on several lines. A line break in a formula is made after a mathematical sign. If it is necessary to refer to more than one formula in the text, the formulas shall be numbered.
Example 1:
	(1)
Symbols used in a formula are defined after the formula, starting with the word “where” without a colon. There is no blank line between the formula and the word "where". If the definitions are short, they are written one after the other. Symbols denoting physical quantities in the text and formulas are written in italic.
Example 2:

where x – weighted average, n1 – number of members of the sample group, x11 – arithmetic mean of the group.
If a formula symbol (weighted average in the example above) has been defined in the text, the definition shall not be repeated after the formula. In the new formula, only the symbols that are being introduced for the first time are defined. Units of measurement shall be presented in the definitions of symbols, not in the formulas.


[bookmark: _Toc191367707]Annex 6 Adding footnotes/endnotes 
[image: C:\Users\anhakk\AppData\Local\Microsoft\Windows\INetCache\Content.MSO\2980E4E7.tmp] 
Figure 13. Footnote numbering
Footnotes are placed at the bottom of the page, just above the bottom margin. In written papers, footnotes must be numbered separately on each page using the Footnote Text style.
In the text, click where you want to insert the note reference mark, click Reference, Insert Footnote to open the dialog box Footnote and Endnote, which allows to select the settings – Restart each page (see Figure 13).
If you want to refer to one and the same footnote in different parts of the text, you should use cross-reference, in order to avoid repeating the same footnote.


[bookmark: _Toc191367708]Annex 7 Adding a caption to a figure or table
To add a caption, click Insert, Reference, Caption or right-click on the figure/picture and select Caption from the shortcut menu. A table or figure caption added with the command Caption is numbered automatically and word processing tools allow you to control the numbering of figure captions as in case of any numbering (lists, page numbers, etc.).
An item must be selected to add a figure caption to it. For tables, simply place the cursor within the table. A window will appear, allowing you to select a new label (e.g., Figure, Table, etc.) for the object. You can also choose whether the caption appears below (Below ...) the selected item, as in the case of a figure, or above (Above ...) the selected item, as with a table, and select the desired numbering format (Numbering). NB! No explanatory text is typed after the label here –  the text is added to the figure or table itself.
When you add a new caption, Word automatically updates the caption numbers—Figure 1 is followed by Figure 2, Table 1 is followed by Table 2, and so on. However, if you remove (delete) a figure or a table, the document needs to be updated. To do so, select the entire document (Ctrl+A), right-click, and select Update Field from the direct menu, or select the entire document and press F9.


[bookmark: _Toc191367709]Annex 8 Creating and using cross-references
Sometimes you need to refer to a figure, table, chapter, header or footer - a word processing object defined by a style located in another place in the document. You can add a bookmark to a text not defined by a style. A cross-reference has a definite structure (see Figure 14).
1. To add a cross-reference at the point where the cursor is positioned, select Reference, Cross-reference or  Insert, Cross-reference, which opens the Cross-reference dialog box.
2. Using the Reference Type drop-down list, choose the reference type (e.g. Table) from the list. If Table is selected for the reference type, all the table captions used in the document are displayed. If you want a cross-reference to function as a link, click the Insert as Hyperlink check box.
3. After you have opened Insert reference to, select the reference layout (e.g. Only Label and Number).
Click the Insert button. A field with the selected text will appear at the point where the cursor is positioned. Thereafter, if you want to, you can add the page number in the same way.
To update a cross-reference, select the cross-reference, right-click and select  Update Field from the shortcut menu. [bookmark: _Ref442182579][bookmark: _Toc442266715]Figure 13. Cross-reference structure
[bookmark: _Ref183641463]Figure 14. Cross-reference structure
This is the text added by the user (in bold)
See Table 1, page 6
These are variables added when using the command Insert, Cross-reference.
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